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Решение задач технической эксплуатации автомобилей методами ими-
тационного моделирования  

1 Основные понятия 
Имитационное моделирование воспроизводит процесс функционирования объекта 

(системы) во времени, при этом имитируются элементарные явления, составляющие 
процесс, с сохранением их логической структуры и последовательности протекания во 
времени. Имитационное моделирование позволяет по исходным данным получить све-
дения о состоянии процесса в определенные моменты времени. 

Имитационное моделирование на ЭВМ позволяет получать наглядную картину пове-
дения системы, рассматривать различные варианты модели, отвечающие различным 
сторонам функционирования системы и возможным структурным преобразованиям, по-
лучать значения необходимых количественных характеристик. Поэтому имитационное 
моделирование в настоящее время получает все большее распространение в исследо-
вании сложных технических систем и технологических процессов. Имитационное моде-
лирование целесообразно применять [2]: 

- не существует законченной математической постановки задачи либо еще не разра-
ботаны аналитические методы решения сформулированной задачи; 

- аналитические методы имеются, но математические процедуры столь сложны и 
трудоемки, что имитационное моделирование дает более простой способ решения за-
дачи; 

- кроме оценки определенных параметров, требуется осуществить наблюдение за 
ходом процесса функционирования системы в течение некоторого времени. При этом 
имитационное моделирование дает возможность полностью контролировать время изу-
чения системы.  

Важными ограничениями имитационного моделирования является то, что [2]: 
- оно не предоставляет непосредственного решения математических задач, что ха-

рактерно для аналитических методов. Оно служит в качестве средства для анализа по-
ведения системы в условиях, которые определяются экспериментатором; 

- разработка хорошей имитационной модели (ИМ) часто обходится дороже создания 
аналитической модели и требует наличия квалифицированных специалистов и больших 
затрат времени; 

- при использовании ИМ применяются многочисленные методы статистического ана-
лиза данных, что усложняет исследование. 

Имитационная модель (ИМ) – это формальное описание логики функционирования 
исследуемой системы во времени, учитывающее наиболее существенные взаимодейст-
вия ее элементов и обеспечивающее возможность проведения статистических экспери-
ментов. 

2 Имитационное моделирование в среде GPSS World [1,2] 
Пакет GPSS (General Purpose Simulation System – система моделирования общего на-

значения) предназначен для имитационного моделирования дискретных систем и вхо-
дит в число наиболее распространенных и используемых на практике средств автомати-
зации имитационного моделирования. Одна из последних версий пакета GPSS для пер-
сональных компьютеров, работающих под управлением операционной системы 
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Windows, называется GPSS World. Система GPSS World позволяет моделировать сис-
темы массового обслуживания (СМО). 

Система массового обслуживания – это совокупность последовательно связанных 
между собой входящих потоков требований на обслуживание (автомобилей, заявок, 
пользователей и т.д.), очередей, каналов обслуживания (станций технического обслужи-
вания, зон технического обслуживания, текущего ремонта автотранспортных предпри-
ятий и т.д.) и выходящих потоков требований после обслуживания (обслуженные или 
отремонтированные автомобили). 

Входящий поток требований – это последовательность входящих требований, нуж-
дающихся в обслуживании в системе и подчиняющихся определенному закону. 

Выходящий поток требований – это последовательность выходящих требований, 
обслуженных в системе и подчиняющихся определенному закону. 

Требование (транзакт) – это объект, поступающий в систему и нуждающийся в опре-
деленном обслуживании в данной системе. Требование является активным элементом в 
моделируемой системе. Под требованием можно понимать сообщение, автомобиль, из-
делие, информацию и т.д. 

Канал обслуживания (или обслуживающий аппарат) – устройство, в котором выпол-
няется обслуживание требования. Основным параметром канала обслуживания являет-
ся время обслуживания, которое, как правило, является случайной величиной. Могут 
быть одно- и многоканальные устройства. 

Имитационная модель СМО – это модель, отражающая поведение системы и изме-
нения ее состояния во времени при заданных потоках требований, поступающих на вхо-
ды системы. Параметры входных потоков требований – внешние параметры СМО. Вы-
ходными параметрами являются величины, характеризующие свойства системы – каче-
ство ее функционирования, – например такие, как: 

•   коэффициенты использования каналов обслуживания; 
•   максимальная и средняя длина очередей в системе; 
•   время нахождения требований в очередях и каналах обслуживания и т.д. 
Имитационное моделирование позволяет исследовать СМО при различных типах 

входных потоков и разной интенсивности поступления требований в систему, а также 
различных дисциплинах обслуживания требований. 

При имитационном моделировании выделяют три представления времени: реальное, 
модельное (системное) и машинное время. 

Реальное время – это время, в котором происходит функционирование моделируе-
мой системы в реальной жизни, например час, смена, год. 

Модельное (системное) время – это время, в котором происходит функционирование 
моделируемой системы при проведении имитационного моделирования на ЭВМ. В сис-
темном времени выполняются следующие действия: 

•   осуществляется переход моделируемой системы из одного состояния в другое; 
•   выполняется синхронизация работы всех компонент имитационной модели; 
•   обеспечивается управление ходом имитационных экспериментов; 
•   обеспечивается параллельная реализация событий в моделируемой системе. 
Машинное время – это время, отражающее затраты времени ЭВМ на проведение 

имитационного моделирования. 
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Система моделирования GPSS World основана на переходе требований (транзактов) 
от блока к блоку (от оператора к оператору) в определенные моменты времени, что на-
зывается событием. Событие – это нечто, меняющее статус связанных с ним состояний 
системы. События соответствуют конкретным изменениям в реальной системе: требо-
вание появилось, требование вошло в очередь, требование обслуживается и т.д.  

Основные объекты GPSS 
Транзакты описывают единицы исследуемых потоков (заявки; требования на обслу-

живание; автомобили, требующие проведения ТО, ТР). Транзакты движутся от блока к 
блоку так, как движутся элементы, которые они представляют. Каждое продвижение 
транзакта инициирует в модели некоторые события (например, занятие поста ТО). Со-
бытия обрабатываются GPSS в соответствующий момент модельного времени. Содер-
жательное значение транзактов определяет разработчик модели. Именно он устанавли-
вает аналогию между транзактами и реальными динамическими элементами модели-
руемой системы, например транзакт соответствует автомобилю, который обслуживается 
в зоне технического обслуживания (ТО) автотранспортного предприятия (АТП). 

Блоки задают логику функционирования ИМ системы и определяют пути движения 
транзактов. Практически все изменения состояний ИМ (события) происходят в результа-
те входа транзактов в блоки и выполнения блоками своих функций. Основные функции 
блоков следующие: создание (генерация) и уничтожение транзактов; задержка транзакта 
на определенный интервал времени; изменение маршрута движения транзакта. 

Одноканальные устройства (Facility) описывают оборудование, которое в любой 
момент времени может быть занято только одним транзактом (например, пост ТО, на 
котором может обслуживаться только один автомобиль). Одноканальные устройства в 
GPSS обеспечивают сбор основной статистической информации о своем функциониро-
вании. 

Многоканальные устройства (Storage) описывают оборудование, которое может 
использоваться несколькими транзактами одновременно (например, ими может модели-
роваться зона ТО, состоящая из нескольких постов; АЗС с несколькими колонками). 
Многоканальные устройства обеспечивают сбор статистической информации о своем 
функционировании.  

Очереди (Queue) обеспечивают сбор основной статистической информации о време-
ни задержки транзактов из-за занятости оборудования.  

Все объекты в GPSS имеют свойства, называемые стандартными числовыми ат-
рибутами (СЧА). А свойства ИМ в целом в GPSS называются системными числовы-
ми атрибутами. Каждый объект GPSS имеет свой набор СЧА. 

Логические ключи используются для блокировки или изменения направления дви-
жения транзактов в зависимости от ранее наступивших в модели событий.  

Арифметические переменные позволяют вычислять арифметические выражения, в 
том числе с числовыми атрибутами объектов. В выражениях могут быть использованы 
функции. 

Логические переменные позволяют проверять несколько условий, исходя из состоя-
ний или значений СЧА объектов, например, для описания условий, определяющих дви-
жение транзактов. 
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Функции позволяют задавать функциональные зависимости между несколькими пе-
ременными, а также переменной и СЧА объектов. 

Таблицы предназначены для сбора статистической информации о случайных вели-
чинах, заданных пользователем. Таблица состоит из частотных групп, в которые зано-
сится число попаданий заданной случайной величины (переменной или СЧА). Для каж-
дой таблицы автоматически вычисляется математическое ожидание и среднеквадрати-
ческое отклонение значений.  

Ячейки и матрицы сохраняемых величин используются для сохранения некоторой 
числовой информации.  

2.1 Создание имитационной модели на языке GPSS 
Операторы GPSS. Правила записи операторов языка GPSS 

Программа имитационного моделирования на языке GPSS представляет собой по-
следовательность операторов – текстовых строк описания: 

•  объектов исследуемой системы; 
•  блоков модели, которые имитируют функционирование элементов системы; 
•  команд управления моделированием. 
Строка оператора GPSS состоит из следующих полей, разделяемых знаком «про-

бел»: 
Номер строки Поле метки Поле операции Поле операндов Поле комментариев 
   А, В, С, D, Е, F, G, Н ; 

 
Поле «номер строки» необязательное. Содержимым поля может быть любое деся-

тичное число из семи символов, в том числе и дробное.  
Содержимое поля метки зависит от типа оператора. В операторах описания объек-

тов содержимым поля является имя объекта, в операторах блоков – метка, в управ-
ляющих операторах поле метки пусто. 

Поле операции содержит символическое обозначение оператора. 
Содержимое поля операндов для разных операторов отличается количеством (от 0 

до 8) и назначением операндов. Если при записи оператора пропускаются необязатель-
ные параметры, то их отсутствие отмечается запятой. 

Поле комментариев (необязательное) содержит информацию, поясняющую назна-
чение оператора, отделяется от прочих полей точкой с запятой. 

Команды управления моделированием  
Для задания условий моделирования, таких как продолжительность моделирования, 

число повторных прогонов ИМ, порядок и условия сбора статистики в GPSS World ис-
пользуются управляющие команды: SIMULATE, START, RESET, CLEAR, HALT, CON-
TINUE, STEP, STOP. Команды могут быть включены в текст ИМ или выбраны в пункте 
Command главного меню GPSS. Поступившие команды выстраиваются в очередь и вы-
полняются одна за другой, пока этот процесс не будет приостановлен или пока не будут 
выполнены все команды. 

Команды SIMULATE и START указывают условия завершения процесса моделирова-
ния (моделирование в течение заданного интервала реального времени, или в течение 
заданного интервала модельного времени, или по окончании обслуживания заданного 
числа транзактов) и имеют следующий вид: 
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SIMULATE [A] 
A – число минут реального времени, по истечении которого моделирование будет за-

вершено и на экран будет выведена накопленная к данному моменту статистическая 
информация. Если команда отсутствует или поле A пусто, то завершение моделирова-
ния определяется другими условиями. 

START  A 
A – начальное значение счетчика завершений. Моделирование завершается, когда 

счетчик завершений примет нулевое или отрицательное значение. Значение счетчика 
завершений уменьшается при поступлении транзактов в блок TERMINATE на величину, 
указанную в блоке TERMINATE. 

Работа с транзактами  
Для создания транзактов и моделирования их поступления в модель предназначен 

блок GENERATE, который имеет следующий формат: 
GENERATE A,[B],[C],[D],[E],[F],[G],[H],[I] 
A – среднее значение интервала времени между моделируемыми транзактами (по 

умолчанию – 0); B – величина разброса возможных значений времени; C – модельное 
время генерации первого транзакта; D – максимальное количество моделируемых тран-
зактов; E – приоритет транзактов (по умолчанию – 0, т.е. самый низкий приоритет); F,…, 
I – количество и формат параметров транзактов. 

Если транзакт начал свое движение, он передвигается от блока к блоку по пути, ука-
занному блок-схемой (логикой работы модели). В тот момент, когда транзакт входит в 
блок, вызывается соответствующая этому блоку подпрограмма. Далее транзакт пытает-
ся войти в следующий блок.  

Для задержки транзактов в течение заданного интервала модельного времени ис-
пользуется блок ADVANCE.  

Формат блока: ADVANCE A, [B] 
Операнды A и B аналогичны соответствующим операндам блока GENERATE. 
Для удаления транзактов из модели используется блок TERMINATE, который имеет 

следующий вид: 
TERMINATE [A]  
Операнд A указывает число (по умолчанию – 0), на которое уменьшается содержимое 

счетчика завершений, значение которого задается командой START. 
Работа с обслуживающими устройствами 

Для моделирования работы одноканальных устройств систем массового обслужи-
вания в GPSS предназначены блоки SEIZE, RELEASE. Занятие транзактом одноканаль-
ного устройства моделируется блоком SEIZE, а его освобождение – блоком RELEASE: 

SEIZE  A 
RELEASE  A 
A – имя устройства, занимаемого (освобождаемого) транзактом; 
Пара блоков SEIZE–RELEASE могут работать с одними и теми же устройствами.  
Для моделирования многоканальных устройств систем массового обслуживания в 

GPSS предназначены блоки ENTER и LEAVE. Занятие транзактом одного из приборов 
многоканального устройства моделируется блоком ENTER, а его освобождение – бло-
ком LEAVE: 
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ENTER A,[B] 
LEAVE A,[B] 
A – имя многоканального устройства, занимаемого (освобождаемого) транзактом; B – 

число занимаемых (освобождаемых) приборов многоканального устройства (по умолча-
нию – 1). 

При работе с многоканальными устройствами необходимо предварительно указать 
количество приборов устройства с помощью оператора 

A    STORAGE    B 
A – имя многоканального устройства; B – количество приборов многоканального уст-

ройства. 
Работа с очередями  

Для сбора и обработки статистики по очередям используются блоки QUEUE и DE-
PART. Блок может быть установлен в любой точке программы, в котором предполагает-
ся возникновение очереди, и имеет следующий формат: 

QUEUE  A,[B] 
A – имя очереди, в которую заносится транзакт; B – число мест в очереди, занимае-

мых транзактом. 
Блок DEPART освобождает требуемое число мест в очереди при вхождении в него 

транзакта. Формат блока: 
DEPART A,[B] 
Операнды A и B определяются аналогично блоку QUEUE. 

Управление перемещением транзактов. Работа с логическими ключами  
Блок TRANSFER изменяет маршрут движения транзактов в зависимости от значения 

первого операнда (в основном или альтернативном направлении) при определенном со-
стоянии оборудования: обслуживающих устройств, очереди, логических ключей и т.п.: 

TRANSFER [A],B,[C],[D] 
A – режим перехода; B – метка первого альтернативного блока; C – метка второго 

альтернативного блока; D – константа, используемая для относительной переадресации 
транзактов. 

Если операнд A блока TRANSFER отсутствует, то транзакт, поступивший в блок 
TRANSFER, безусловно отправляется в блок с меткой, указанной в операнде B. 

Если операнд A – число от 0 до 1, то он определяет вероятность перехода транзакта 
по адресу C. При этом операнд B определяет альтернативный адрес. 

Если операнд A равен «BOTH», то транзакт делает попытку перемещения в блок с 
меткой B. При невозможности войти в блок с адресом B, транзакт перемещается в блок 
с меткой, указанной в операнде C. 

Если операнд A равен «ALL», то транзакт делает попытку перемещения в блок с мет-
кой B. При невозможности войти в данный блок, транзакт делает попытку перемещения 
в блок, следующий за блоком с адресом B через D блоков, если и эта попытка безус-
пешна – то в блок, следующий за блоком с адресом B через 2D блоков. Адрес последне-
го блока, в который может перемещаться транзакт, записывается в операнде C. 

Блок TEST определяет направление движения транзакта в зависимости от выполне-
ния условия, заданного алгебраическим соотношением:  

TEST XX A,B,[C] 
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XX – знак логической операции: L – меньше, G – больше, E – равно, LE – меньше или 
равно, GE – больше или равно, NE – не равно; A, B – сравниваемые значения или СЧА; 
C – метка блока, куда перемещается транзакт в случае невыполнения заданного усло-
вия. 

При выполнении условия, записанного в блоке TEST, транзакт переходит в следую-
щий блок. В противном случае он направляется в блок с меткой, содержащейся в опе-
ранде C. Если операнд C не задан, то транзакт задерживается в блоке TEST до выпол-
нения условия. 

Работа с переменными и функциями  
Переменные и функции, используемые в ИМ на GPSS, должны быть предварительно 

определены. Определение переменных выполняется операторами: 
N   VARIABLE     A  определение арифметических переменных 
N   FVARIABLE   A  определение арифметических переменных с плаваю-

щей точкой 
N   BVARIABLE   A  определение логических переменных 
N – имя или номер переменной; 
A – арифметическое или логическое выражение. 
Выражениями, используемыми в арифметических и логических переменных, являют-

ся комбинации математических операторов, стандартных функций, СЧА и констант, со-
ставленные по правилам математики. В таблице 1 представлены операторы и стан-
дартные функции, используемые в выражениях, в порядке приоритетов их вычисления. 

 
Таблица 1 – Операции и стандартные функции GPSS 

Обозначение Содержание Обозначение Содержание 
Операции отношения Логические операции 
‘G’ Больше ‘NOT’ Логическое отрицание 
‘L’ Меньше ‘AND’ Логическое умножение 
‘E’ Равно ‘OR’ Логическое сложение 
‘NE’ Не равно Стандартные функции 
‘LE’ Меньше или равно ABS(.) Абсолютное значение 
‘GE’ Больше или равно ATN(.) Арктангенс в радианах 
Арифметические операции COS(.) Косинус в радианах 
^ Возведение в степень INT(.) Целая часть 
# Умножение EXP(.) Экспонента 
/ Деление LOG(.) Натуральный логарифм 
\ Деление нацело SIN(.) Синус в радианах 
@ Деление по модулю SQR(.) Квадратный корень 
+ Сложение TAN(.) Тангенс в радианах 
– Вычитание  
 
Определение функций выполняется в GPSS с помощью оператора  
N FUNCTION A,B  
N – имя или номер функции; A – аргумент функции; 
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B – указатель типа функции (в частности, D – для дискретной, C – для непрерывной) и 
числа точек табуляции. За оператором описания функции следует описание множества 
значений аргумента и функции, которые отделяются друг от друга символом «/». 

Определение значения функции выполняется чтением ее СЧА с именем FN. 
Значения переменных и функций вычисляются автоматически (уточняются) GPSS 

всякий раз при поступлении транзактов в блоки, использующие данные переменные или 
функции. 

Работа с константами, ячейками, сохраняемых величин и таблицами  
Для удобства отладки программы ИМ на GPSS допускает принудительное присвое-

ние числовых значений строковым переменным или именам объектов с помощью опе-
ратора 

N  EQU  A 
N – имя объекта GPSS или константы; A – порядковый номер объекта GPSS или чи-

словое значение константы. 
GPSS позволяет использовать пользовательские переменные (ячейки и матрицы 

ячеек), значения которых сохраняются или изменяются в процессе моделирования.  
Значения ячеек, необходимо проинициализировать в начале текста модели операто-

ром 
INITIAL A,B 
A – СЧА ячейки; B – начальное значение. 
Например: Initial X$Time,10; определение ячейки Time и присваивание ей 

начального значения 10 
Для изменения значений ячеек используется оператор  
SAVEVALUE A[+,–],B 
A – номер или имя ячейки с указанием режима изменения: накопление (+), вычитание 

(–), замещение (без дополнительных символов); B – величина, используемая для моди-
фикации значения ячейки. 

Для накопления выборочных значений случайной величины и статистической обра-
ботки выборки используется объект GPSS-таблица, который является аналогом сгруп-
пированного статистического ряда распределения (гистограммы) и описывается опера-
тором 

N    TABLE    A,B,C,D 
N – имя таблицы; A – СЧА, значение которого учитывается в таблице; B – значение 

правой границы первого интервала сгруппированного статистического ряда распределе-
ния; C – ширина интервала сгруппированного статистического ряда распределения (це-
лое число); D – количество интервалов сгруппированного статистического ряда распре-
деления. 

Выборочные значения попадают в таблицу при входе транзактов в блок TABULATE, 
формат которого следующий: 

TABULATE    A 
A - имя таблицы, в которой табулируется СЧА, соответствующий оператору TABLE. 
По результатам моделирования предоставляются частоты попадания значений ис-

следуемого СЧА объекта в каждый интервал таблицы, а также основные числовые ха-
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рактеристики выборки (объем, среднее арифметическое значение и т. д.). Числовые ха-
рактеристики выборок, записанных в таблицы, доступны и в процессе моделирования. 

Оператор QTABLE определяет таблицу для очереди 
N   QTABLE  A,B,C,D 
N – имя таблицы, A – имя очереди, B – значение правой границы первого интервала 

сгруппированного статистического ряда распределения; C – ширина интервала сгруппи-
рованного статистического ряда распределения (целое число); D – количество интерва-
лов сгруппированного статистического ряда распределения. 

Моделирование случайных величин в GPSS 
Для моделирования случайных величин с заданными законами распределения в 

GPSS возможно использование библиотечных функций или задание требуемой функции 
распределения в табличном виде путем аппроксимации непрерывными функциями. 

Встроенная библиотека GPSS содержит функции для моделирования случайных ве-
личин, имеющих следующие законы распределения:  равномерное (Uniform) ; экспонен-
циальное (Exponential);  гамма (Gamma); Вейбулла (Weibull); нормальное (Normal); лога-
рифмическое нормальное (LogNormal); биномиальное (Binomial); геометрическое (Geo-
metric); дискретное равномерное (Discrete Uniform); пуассоновское (Poisson); логистиче-
ское (Logistic); логлапласово (LogLaplace); треугольное (Triangular). 

Для моделирования случайной величины, имеющей экспоненциальное распределе-
ние, используется библиотечная функция 

EXPONENTIAL(Stream,Locate,Scale) 
Stream – номер генератора случайных чисел (от 1 до 7); Locate – величина сдвига 

(константа, добавляемая к значению моделируемой величины); Scale – параметр фор-
мы распределения (математическое ожидание случайной величины при Locate =0). 

Для моделирования случайной величины, имеющей распределение Вейбулла, ис-
пользуется библиотечная функция 

WEIBULL(Stream,Locate,Scale,Shape) 
Stream – номер генератора случайных чисел (от 1 до 7); Locate – величина сдвига 

(константа, добавляемая к значению моделируемой величины); Scale – параметр мас-
штаба функции распределения; Shape – параметр, определяющий форму распределе-
ния. 

Для моделирования случайной величины, подчиняющейся нормальному закону рас-
пределения, используется библиотечная функция  

NORMAL(Stream,Mean,StdDev)  
Stream – номер генератора случайных чисел (от 1 до 7); Mean – математическое ожи-

дание; StdDev – среднеквадратическое отклонение. 
2.2 Работа в системе GPSS World  

Создание, сохранение и открытие файлов имитационных моделей 
Для создания новой ИМ необходимо в главном меню GPSS World выбрать пункт «File 

→ New», затем в диалоговом окне выбрать режим создания новой модели. В рабочем 
окне GPSS World появится новое текстовое окно с заголовком «Untitled Model 1», в кото-
ром записывается текст создаваемой ИМ. 

Для сохранения текста создаваемой ИМ необходимо в главном меню GPSS World вы-
брать пункт «File → Save» или «File → Save As». Во втором случае пользователю бу-
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дет предложено задать новое имя для файла с текстом ИМ. Файл с текстом модели в 
GPSS имеет расширение «gps». 

Для открытия уже существующего файла с текстом ИМ необходимо в главном меню 
GPSS World выбрать пункт «File → Open». 

Трансляция и запуск имитационной модели в GPSS 
Подробную информацию о назначении блоков и примеры их использования можно 

получить в разделе справки GPSS (пункт «Help → Help Topics» главного меню) или при 
вставке блоков с помощью пункта главного меню «Edit → Insert GPSS Blocks…». В 
данном режиме пользователю предоставляется возможность указывать значения пара-
метров блоков в диалоговом окне. 

После написания текста ИМ на языке GPSS модель необходимо оттранслировать, т.е. 
преобразовать последовательность текстовых операторов в последовательность ко-
манд, написанную в машинных кодах компьютера. Для этого необходимо выбрать пункт 
создания модели «Command → Create Simulation» главного меню. 

Если при трансляции в тексте ИМ будут обнаружены некорректные директивы, значе-
ния параметров или синтаксические ошибки, то в появившемся окне документирования 
событий («JOURNAL») GPSS приведет список ошибочных строк. Для повторной транс-
ляции модели после исправления ошибок используется пункт главного меню «Command 
→ Retranslate». 

После успешной трансляции GPSS сообщит о готовности модели к работе строкой 
«Ready», и станут доступны команды управления моделированием главного меню 
«Command». 

Для запуска процедуры моделирования в конце текста ИМ следует задать команду 
«START A» или выбрать пункт главного меню «Command → START» и в диалоговом 
окне указать начальное значение счетчика завершений. 

Средства отладки имитационных моделей 
GPSS имеет в своем составе развитые средства отладки ИМ, доступ к которым осу-

ществляется из пункта главного меню «Window → Simulation Window». 
GPSS реализует пошаговую отладку модели с одновременным отображением про-

цесса перемещения транзактов между блоками ИМ в окне «BLOCK ENTITIES». Для это-
го в главном меню необходимо выбрать пункт «Window → Simulation Window → Block 
Window». 

Для отображения в динамике значений некоторых выражений или СЧА объектов сле-
дует выбрать пункт построения временных диаграмм «Window → Simulation Window 
→ Plot Window» главного меню GPSS. В появившемся диалоговом окне «Edit Plot Win-
dow» следует указать комментарий (поле «Label») и интересующее арифметическое или 
логическое выражение (поле «Expression»), затем добавить его в список кнопкой «Plot». 
В поле «Title» следует задать имя временной диаграммы, в поле «Time Range» – вели-
чину отображаемого модельного времени, в полях «Min Value» и «Max Value» – мини-
мальное и максимальное значения отображаемой величины. По завершении нажать 
кнопку «OK». 

Для отображения   гистограммы частот значений случайной величины, накопленной в 
одной из таблиц ИМ, в главном меню GPSS следует выбрать пункт «Window → Simula-
tion Window → Table Window». Затем в диалоговом окне выбрать имя нужной табли-
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цы. Аналогично с помощью команды главного меню «Window → Simulation Window» 
можно получить доступ к текущим значениям ячеек матриц, таблиц и сохраняемых ве-
личин, к характеристикам очередей, одно- и многоканальных обслуживающих устройств. 

2.3 Анализ результатов моделирования в GPSS 
После завершения процедуры моделирования GPSS автоматически открывает окно 

отчета «REPORT», содержащее стандартную выходную информацию о результатах мо-
делирования. 

Выходной файл статистики состоит из подразделов, содержащих стандартную стати-
стику об объектах GPSS, используемых в данной модели (устройствах, очередях и т. д.). 
Начинается файл статистики с заголовка, который содержит имя модели, дату и время 
моделирования. Далее следует выходная информация, содержащая следующие основ-
ные сегменты вывода: 

Информацию о результатах работы модели 
START TIME END TIME BLOCKS FACILITIES STORAGES 
 
Обозначения: START TIME – абсолютное модельное время в момент начала модели-

рования; END TIME – абсолютное время или момент, когда счетчик завершений принял 
значение 0; BLOCKS – количество блоков, использованных в текущей модели, к моменту 
завершения моделирования; FACILITIES – количество одноканальных устройств, ис-
пользованных в модели к моменту завершения моделирования; STORAGES – количест-
во многоканальных устройств, использованных в текущей модели к моменту завершения 
моделирования. 

Информация об именах 
NAME VALUE 

Обозначения: NAME - содержит имена, используемые в программе модели; VALUE – 
определяет числовое значение (номер), соответствующее имени, устанавливает на-
чальный номер GPSS равным 10000. 

Информация о блоках текущей модели 
LABEL LOC BLOCK TYPE ENTRY COUNT CURRENT COUNT RETRY 

 
Обозначения: LABEL – метка оператора, связанного с блоком GPSS; LOC – номер 

строки модели, связанной с блоком;  BLOCK TYPE – тип блока GPSS; ENTRY COUNT – 
количество транзактов, вошедших в данный блок после последнего выполнения команд 
с начала процедуры моделирования; CURRENT COUNT – количество транзактов, нахо-
дящихся в данном блоке и ожидающих выполнения некоторых условий; RETRY – коли-
чество транзактов, ожидающих выполнения некоторых условий. 

Информация об одноканальных устройствах 
FACILITY ENTRIES UTIL AVE. TIME AVAILABLE  OWNER PEND INTER RETRY DELAY 

 
Обозначения: FACILITY – номер или имя одноканального устройства; ENTRIES – ко-

личество транзактов, вошедших в устройство после начала работы программы; UTIL. – 
часть периода моделирования, в течение которого устройство было занято (коэффици-
ент загрузки); AVE. TIME – среднее время занятости устройства одним транзактом в те-
чение процедуры моделирования; AVAILABLE – состояние готовности устройства в кон-
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це периода моделирования; OWNER – номер последнего транзакта, занимавшего уст-
ройство (0 означает, что устройство не занималось); PEND – количество транзактов, 
ожидающих устройство; INTER – количество транзактов, обработка которых прервана на 
устройстве в данный момент модельного времени; RETRY – количество транзактов, 
ожидающих выполнения некоторых условий; DELAY – количество транзактов, ожидаю-
щих занятия устройства (включая транзакты, ожидающие освобождение устройства). 

Информация об очередях 
QUEUE MAX CONT. ENTRIES ENTRIES(0) AVE.CONT AVE.TIME AVE.(–0) RETRY 

 
Обозначения: QUEUE – имя или номер объекта типа «очередь»; MAX – максимальное 

содержимое объекта типа «очередь» в течение периода моделирования; CONT – теку-
щее содержимое объекта типа «очередь» в момент завершения моделирования; EN-
TRIES – общее количество входов в очередь в течение периода моделирования; EN-
TRIES(0) – общее количество входов в очередь с нулевым временем ожидания; 
AVE.CONT – среднее значение длины очереди; AVE.TIME – среднее время, проведен-
ное транзактом в очереди с учетом всех входов в очередь; AVE.(–0) – среднее время, 
проведенное транзактом в очереди без учета «нулевых» входов в очередь; RETRY – ко-
личество транзактов, ожидающих специальных условий, зависящих от состояния объек-
та типа «очередь». 

Информация о многоканальных устройствах 
STORAGE CAP. REMAIN MIN MAX ENTRIES AVL. AVE.C. UTIL. RETRY DELAY 

 
Обозначения: STORAGE – имя или номер многоканального устройства; CAP. – коли-

чество каналов, заданное оператором STORAGE; REMAIN – число свободных каналов в 
конце периода моделирования; MIN – минимальное количество использовавшихся кана-
лов за период моделирования; MAX – максимальное количество использовавшихся ка-
налов за период моделирования; ENTRIES – количество входов в многоканальное уст-
ройство за период моделирования; AVL. – состояние готовности многоканального уст-
ройства в конце периода моделирования; AVE.C. – среднее число занятых каналов в 
устройстве за весь период моделирования; UTIL. – часть периода моделирования, в те-
чение которого многоканальное устройство использовалось; RETRY – количество тран-
зактов, ожидающих специальные условия, зависящие от состояния устройства; DELAY – 
количество транзактов, ожидающих возможность входа в блок ENTER. 

Информация о ячейках памяти 
SAVEVALUE VALUE VALUE 

 
Обозначение: SAVEVALUE – имя или номер ячейки; VALUE – значение ячейки в конце 

моделирования; RETRY – количество транзактов, ожидающих наступления специальных 
условий, зависящих от состояния ячейки. 

Более подробная информация о работе с системой GPSS World представлена в [1, 2]. 
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3 Лабораторные работы 
3.1 Создание имитационной модели функционирования автозаправочной стан-

цией (АЗС) и изучение характеристик ее работы 
Задание: создайте в системе GPSS World Student Version имитационную модель 

функционирования АЗС и равномерным распределением времени поступления автомо-
билей на заправку и времени заправки автомобилей. Количество топливозаправочных 
колонок принимайте равным 1, 2, 3. По созданной имитационной модели выполните 
анализ работы АЗС и определите оптимальное количество колонок. Данные по вариан-
там даны в таблице А.1.  

Создание имитационной модели 
Имитационная модель АЗС представляет собой одноканальную незамкнутую СМО. 

Определим основные элементы СМО при моделировании АЗС. 
Входящий поток образуется автомобилями, требующими заправки топливом, и ха-

рактеризуется интервалами времени поступления требований на заправку. Автомобили 
моделируются транзактами. В соответствии с заданием интервалы времени поступле-
ния автомобилей имеют равномерное распределение, для которого задано среднее 
значение и возможный разброс значений времени.  

Каналом обслуживания являются АЗС, которые характеризуются количеством топли-
возаправочных колонок и временем обслуживания одного требования (временем за-
правки одного автомобиля), которое распределено по равномерному закону в соответ-
ствии с заданием. АЗС моделируется одноканальным устройством FACILITY (если одна 
колонка) или многоканальным устройством  STORAGE , для которого задают количество 
каналов обслуживания соответственно 2, 3 (по количеству топливозаправочных колонок 
АЗС). 

Очередь образуется автомобилями, требующими заправки, если все колонки заняты 
и характеризуется средней и максимальной длиной очереди, средним временем нахож-
дения требования в очереди. Очередь моделируется объектом QUEUE. 

Выходящий поток образуется заправленными автомобилями (обслуженные требова-
ния). 

Функциональная схема полученной имитационной модели АЗС представлена на рис. 
1. Пример имитационной модели в GPSS World и пояснения даны в таблицах 2, 3.  Вре-
мя моделирования работы АЗС равно времени одних суток (в минутах): 24 ч. х 60 мин. = 
1440 мин. 

Порядок выполнения 
1. Создайте имитационные модели АЗС с 1, 2, 3 колонками (примеры моделей см. 

ранее). Для создания ИМ АЗС с 3 колонками в операторе STORAGE укажите коли-
чество колонок 3. Создание и трансляция модели описано в п. 2.2.  

2.  Сохраните имитационные модели на диске R с именами АЗС1.gps; АЗС2.gps; 
АЗС3.gps и распечатайте их. Выполните трансляцию моделей и сохраните отчеты 
REPORT по результатам моделирования с именами АЗС1.gpr; АЗС2.gpr; АЗС3.gpr 
и распечатайте их. 

3. Выполните анализ работы АЗС. Для этого из полученных отчетов выберите необ-
ходимы данные и заполните таблицу 4. 
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Создание
транзакта

Присоединение к 
очереди

Занятие одно- 
или моноканального 

устройства 
Выход из очереди

 

Обслуживание на одно- 
или многоканальном 

устройстве  
 

Освобождение 
устройства

 

Удаление 
транзакта из 

системы 
 

Рисунок 1 - Функциональная схема полученной имитационной модели АЗС  
 
Таблица 2 - Имитационная модель АЗС с 1 колонкой в GPSS World 

* Имитационная модель АЗС с 1 колонкой * 
 GENERATE  5.2,2.0 ; 

; 
; 
; 

создание транзактов и моделирование их по-
ступления в модель (т.е. моделирование посту-
пления автомобилей на АЗС) со средним вре-
менем 5,2±2,0 мин. 

 QUEUE ZAPRAVKA ; 
; 

Постановка автомобиля в очередь на АЗС, имя 
очереди ZAPRAVKA 

 SEIZE KOLONKA ; 
; 

Занятие транзактом одноканального устройства 
KOLONKA (занятие автомобилем колонки) 

 DEPART ZAPRAVKA ; 
; 

Выход транзакта (автомобиля) из очереди ZA-
PRAVKA 

 ADVANS 6.3,3.4 ; 
; 

задержка транзакта (выполнение заправки ав-
томобиля) в течение заданного интервала вре-
мени 6,3±3,4 мин. 

 RELEASE KOLONKA ; 
; 
; 

Освобождение транзактом одноканального уст-
ройства KOLONKA (освобождение автомоби-
лем колонки) 

 TERMINATE  ; 
; 

Удаление транзакта из модели (автомобиль по-
кидает систему) 

 GENERATE 1440 ; 
; 

Задание времени моделирования  
1440 мин (1 сутки) 

**************************************************** 
 TERMINATE 1 ; Остановить моделирование 
 START 1 ; Запуск процедуры моделирования 
 
Таблица 3 – Имитационная модель АЗС с 2 колонками в GPSS World 
********************************************************************************************** 
KOLONKA  STORAGE 2   ; АЗС С 2 КОЛОНКАМИ 

GENERATE 5.2,2.0 ; ПОСТУПЛЕНИЕ А/М НА АЗС 



 

17 

; СО СРЕДНИМ ВРЕМЕНЕМ 5,2 ±2,0 мин 
QUEUE ZAPRAVKA  ; ВХОД В ОЧЕРЕДЬ НА АЗС 
ENTER KOLONKA  ; ЗАНЯТИЕ АВТОМОБИЛЕМ КОЛОНКИ 
DEPART ZAPRAVKA  ; ВЫХОД ИЗ ОЧЕРЕДИ НА АЗС 
ADVANCE 6.3,3.4 ; ЗАПРАВКА А/М НА КОЛОНКЕ 

;  СО СРЕДНИМ ВРЕМЕНЕМ 6,3 ±3,4 мин 
LEAVE KOLONKA  ; ОСВОБОЖДЕНИЕ АВТОМОБИЛЕМ  

; КОЛОНКИ 
TERMINATE   ; АВТОМОБИЛЬ ПОКИДАЕТ СИСТЕМУ 
GENERATE 1440  ; ЗАДАНИЕ ВРЕМЕНИ МОДЕЛИРОВАНИЯ 

; 1440 МИН 
***************************************************** 

TERMINATE 1   ; ОСТАНОВИТЬ МОДЕЛИРОВАНИЕ 
START 1    ; ЗАПУСК ПРОЦЕДУРЫ МОДЕЛИРОВАНИЯ 

 
Таблица 4 –Результаты моделирования АЗС 

Количество 
топливоза-
правочных 
колонок на 
АЗС ПОСТn  

Очередь QUEUE Одноканальное FACILITY или многока-
нальное STORAGE устройство 

Средняя 
длина очере-

ди 
AVE.CONT. 

Среднее время 
нахождения ав-

томобиля в 
очереди Тср.оч,  

мин;  
AVE.TIME 

Количество 
выполненных 
заправок за 
время моде-
лирования 

NЗАПР, 
ENTRIES 

Коэффи-
циент ис-
пользова-
ния (за-

грузки) ко-
лонки Кисп, 

UTIL. 

Среднее 
число за-
нятых ко-

лонок 
AVE.C. 

 1 2 3 4 5 
1     для АЗС с 

1 колонкой 
AVE.C.= 

UTIL. 
2      
3      

Примечание – Расшифровка обозначений в отчете REPORT дана в п. 2.3 
 
4. На основании анализа таблицы 4 сделайте вывод об оптимальном количестве ко-

лонок на АЗС, исходя из следующих критериев: коэффициент использования (за-
грузки) UTIL. колонки находится в пределах от 0,5 до 0,9; среднее число автомо-
билей одновременно находящихся на АЗС (т. е. заправляющихся и находящихся в 
очереди AVE.C.+ AVE.CONT.) не должно превышать 5; среднее время ожидания 
заправки AVE.TIME не должно превышать среднее время заправки [2] (критерии 
могут изменяться преподавателем) 

5. Письменно ответьте на контрольные вопросы. 
Содержание отчета 
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Тема, задание, исходные данные, основные элементы СМО при моделировании АЗС, 
функциональная схема полученной имитационной модели АЗС, распечатка (либо сохра-
нение на диске R) файлов имитационных моделей (АЗС1.gps; АЗС2.gps; АЗС3.gps) и 
файлов отчетов (АЗС1.gpr; АЗС2.gpr; АЗС3.gpr); таблица 4; вывод об оптимальном ко-
личестве колонок на АЗС; ответы на контрольные вопросы. 

Контрольные вопросы 
1. Укажите назначение и формат блоков GENERATE, TERMINATE, SEIZE, RELEASE, 

QUEUE, DEPART, ADVANCE, ENTER, LEAVE, поясните задаваемые  параметры. 
2. Какая информация содержится об одноканальных устройствах в выходном файле 

статистики «REPORT» системы GPSS Word? 
3. Какая информация содержится об очередях в выходном файле статистики 

«REPORT» системы GPSS Word? 
4. Какая информация содержится об одноканальных устройствах в выходном файле 

статистики «REPORT» системы GPSS Word? 
 

3.2 Оптимизация зоны технического обслуживания (ТО) автомобилей авто-
транспортного предприятия (АТП) с использованием имитационного моделирова-
ния 

Задание: Определить оптимальное количество постов первого технического 
обслуживания (ТО-1) по критерию минимальных суммарных затрат от простоя 
автомобилей в ожидании обслуживания и затрат от простоя постов ТО-1  в ожидании 
требований на обслуживание. При этом необходимо рассмотреть зону ТО-1 с 1, 2, 3 и 
более постами. 

Исходные данные: Исходные данные принимаются в зависимости от номера 
варианта (см. таблицу А.2).  

Порядок выполнения 
1. Подготовка данных для моделирования. Технологический расчет зоны ТО 
1.1 Корректировка нормативных значений пробегов и трудоемкостей. 
Нормативные значения пробегов до ТО-1 LНТО1, до ТО-2 LНТО2, до списания LНСП, 

трудоемкости ТО-1 приводим к заданным условиям эксплуатации в соответствии с ТКП 
248-2010 с помощью формул [4]:  

H
TO TOL L K K1 1 1 3− −= ⋅ ⋅ , км; 

H
TO TOL L K K2 2 1 3− −= ⋅ ⋅ , км; 

H
СП СПL L K K K1 2 3= ⋅ ⋅ ⋅ , км; 

где К1 – коэффициент, учитывающий категорию условий эксплуатации; К2 – коэффици-
ент, учитывающий модификацию ПС и организацию его работы; К3 – коэффициент, учи-
тывающий климатический район. Коэффициенты принимаем по [4]: К1 = 0,8; К2 = 1 (для 
базовых автомобилей или автобусов) или К2 = 0,85 (для самосвалов); КТО3 = 1; КСП3 = 1,1. 

Нормативное значение трудоемкости ТО-1 1
Н
ТОt −  приводим к заданным условиям экс-

плуатации с помощью формул [4]:  
Н

ТО ТОt t К К К К2
1 1 2 4 5 6− −= ⋅ ⋅ ⋅ ⋅ , чел.-ч; 

где К2 4  - коэффициент, учитывающий пробег с начала эксплуатации; К5 – коэффициент, 
учитывающий число автомобилей обслуживаемых и ремонтируемых на АТП и число 
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технологически совместимых групп ПС; К6 – коэффициент, учитывающий период экс-
плуатации. 

По [4] принимаем:  К2 = 1 (для базовых автомобилей или автобусов) или К2 = 1,15 (для 
самосвалов); К2 4  = 1; К5 = 1; К6 = 1. 

1.2 Определяем годовую производственную программу по ТО-1 (количество воздей-
ствий ТО-1 за год) 

Для этого определяем коэффициент технической готовности по формуле [3]: 

КТ 1
ТО-ТР 4

СC

1=
Д1+ L ( )

1000

α
⋅⋅

 

где CCL – среднесуточный пробег, км; ТО-ТРД – нормативный простой ПС в ТО и ТР, 
дн./1000 км., для автобусов принимаем ДТО-ТР = 0,50 дн./1000 км, для грузовых автомо-
билей ДТО-ТР = 0,60 дн./1000 км; К4 – коэффициент корректирования простоев ПС в ТО и 
ТР в зависимости от пробега с начала эксплуатации, для заданного пробега К1 4 = 0,7.  

Рассчитываем годовой пробег автомобиля по формуле [3]: 
LГ И РАБ.Г. СС ТL = A Д α⋅ ⋅ ⋅ , км.; 

где ДРАБ.Г. – количество дней работы в году, дн.(см. исходные данные), Аи -  количество 
автомобилей на автотранспортном предприятии (АТП). 

Определяем количество воздействий ТО за год по формулам [3]: 

=Г Г
СП

СП

LN
L

, 

2
2−

= −Г ГГ
СП

ТО

LN N
L

, 

1 2
1−

= − −Г Г ГГ
СП

ТО

LN N N
L

. 

1.3 Определяем такт поста и ритм производства 
Такт поста ТО-1 определятся 

1τ −= +ТО
П П

П

t t
Р

, 

где 1−ТОt  - трудоемкость ТО-1, чел.-ч; ПР  - количество рабочих, одновременно работаю-
щих на посту, Pп = 3 чел. по [3]; Пt  - время на перемещение автомобиля на пост и съез-
да с поста, Пt =0,03…0,05 часа. 

Ритм производства  
СМ

П
C

Т СR
N ϕ

⋅
=

⋅
, 

где СМТ  - длительность  смены, СМТ =8 ч.; CN  - суточная программа работ по техниче-
скому обслуживанию, ϕ  - коэффициент резервирования постов, принимаем ϕ =1,25 по  
[3] , С=1 – количество смен работы зоны ТО-1.  

Суточная программа по ТО-1 определяется 
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1
_ 1

, _

Г

C ТО
РАБ ЗОНЫ ТО

NN
Д− = ,  

где , _РАБ ЗОНЫ ТОД  - число дней работы зоны ТО в году, в соответствие с исходными дан-
ными , _РАБ ЗОНЫ ТОД =252 дня. 

Требуемое количество универсальных постов ТО по детерминированной типовой 
методике технологического расчета определяется [3] 

1
П

ТО
П

Х
R
τ

− = . 

2. Создание имитационной модели зоны ТО-1 с использованием СМО, расчет 
ее параметров 

Определим основные элементы СМО при моделировании зоны ТО-1 АТП.  
Входящий поток образуется автомобилями, требующими технического обслуживания 

ТО-1, и характеризуется интервалами времени поступления требований на обслужива-
ние ТТО-ТО, час. Автомобили моделируются транзактами. 

Для моделирования простейшего потока требований интервал времени между сосед-
ними событиями должен иметь экспоненциальное распределение, поэтому интервалы 
времени поступления автомобилей на ТО распределялись по экспоненциальному зако-
ну.  

Каналами обслуживания (обслуживающими аппаратами) являются посты ТО-1, кото-
рые характеризуются количеством постов n  и временем обслуживания одного требова-
ния, которое равно такту поста Пτ , час. Зона ТО моделируется одноканальным устрой-
ством FACILITY (если один пост в зоне ТО) и многоканальным устройством  STORAGE, 
для которого задают количество каналов обслуживания соответственно 2, 3 и 4 (по ко-
личеству постов зоны ТО). Интервалы времени на обслуживание одного автомобиля за-
давались также по экспоненциальному закону с математическим ожиданием равным 
такту поста. 

Очередь образуется автомобилями, требующими технического обслуживания, если 
все посты ТО-1 заняты. Очередь характеризуется средней и максимальной длиной оче-
реди, средним временем нахождения требования в очереди. Очередь моделируется 
объектом QUEUE. 

Выходящий поток образуется автомобилями, которые прошли техническое обслужи-
вание (обслуженные требования). 

СМО является замкнутой, т.к. обслуживаются автомобили только своего АТП, при 
этом  автомобили, прошедшие ТО, возвращаются к выполнению транспортной работы, а 
затем после определенного пробега вновь проходят ТО, процесс повторяется в цикле. 

2.3 Расчет показателей СМО 
Определяем математическое ожидание (среднее значение) интервала времени рабо-

ты зоны ТО-1, через которые автомобиль поступит на ТО-1 - ТТО-ТО, час.  
Для этого находим количество дней, через которые производится ТО-1 автомобиля 

дней
CC

N
L

ТО-1L
=

.
 

Количество дней округляется до целых. 
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Математическое ожидание (среднее значение) интервала времени работы зоны ТО-1, 
через которые автомобиль поступит на ТО-1 

TO TO дней CMT N T C час,− = ⋅ ⋅ . 
Принимаем время моделирования равным 1 год. Тогда время моделирования в часах 

определяется 
МОД СМТ Т С РАБ.Г.Д= ⋅ ⋅ , 

где длительность смены СМТ =8 часов, количество смен С=1, количество дней работы 
зоны ТО-1 в год РАБ.Г.Д .=252 дня. 

МОДТ ч8 1 252 2016 .= ⋅ ⋅ =  
2.2 Составление имитационной модели замкнутой СМО и моделирование. 
Одноканальная замкнутая СМО моделирует зону ТО-1 с одним постом. Зона ТО-1 

моделируется одноканальным устройством FACILITY. Пример имитационной модели 
представлен ниже. Выделенные цифры необходимо заменить на рассчитанные выше 
значения. В имитационной модели используются следующие переменные: AVTO  -- ко-
личество заданных автомобилей Аи, ед; TIME_DO_TO - среднее время, через которое 
автомобиль требует ремонта и поступает в зону ТО  ТТО-ТО, час; OBSL - среднее время 
выполнения одного технического обслуживания ТОt 1− , час; TIME_MODEL - время моде-
лирования работы зоны ТО ТМОД, час, которое соответствует времени работы зоны ТО в 
течение одного года. 
 
* Модель одноканальной замкнутой СМО  с простейшим потоком требований* 
**************************************************************** 

INITIAL  X$AVTO,100   ; задание количества а/м = 100 ед. 
INITIAL  X$TIME_DO_TO,320  ; задание среднего времени, через которое 

; выполняется ТО-1 =320 ч. 
INITIAL  X$OBSL,1.81   ;задание среднего времени  

; на выполнение ТО-1 =1.81 ч. 
INITIAL  X$TIME_MODEL,2016  ; задание времени моделирования  

; работы зоны ТО-1 2016 ч. 
**************************************************************** 
INFORM  QTABLE  ON_TO,0,2,100   ;сбор статистических данных для таблицы  

       ;INFORM об очереди ON_TO 
GENERATE  ,,,X$AVTO   ;генерация транзактов, соответствующих  
     ;количеству автомобилей 

WORK  ADVANCE  (EXPONENTIAL(1,0,X$TIME_DO_TO)) ; задержка автомобиля  
;на время выполнение транспорной рабо-
ты, распред. по экспоненциальному закону 

QUEUE  ON_TO    ; поступление а/м в ОЧЕРЕДЬ на пост ТО  
     ;(имя очереди ON_TO) 
SEIZE  POST_TO    ; занятие поста ТО (имя поста POST_TO) 
DEPART  ON_TO    ; выход а/м из очереди 
ADVANCE  (EXPONENTIAL(1,0,X$OBSL)) ; задержка а/м на время  

;выполнения  
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ТО-1, которое  
;распределено по экспоненц. закону 

RELEASE  POST_TO   ; освобождение а/м поста ТО 
TRANSFER  ,WORK   ; переход на блок с меткой Work 

**************************************************************** 
GENERATE  X$TIME_MODEL  ; задание времени моделирования  

;зоны ТО  
TERMINATE  1    ;остановить моделирование 
START  1     ;запуск процедуры моделирования 

 
Многоканальная замкнутая СМО моделирует зону ТО-1 с 2 и более постами. Зона 

ТО-1 моделируется многоканальным устройством  STORAGE, для которого задают ко-
личество каналов обслуживания равное количеству постов ТО-1 в зоне. Пример имита-
ционной модели представлен ниже. Выделенные цифры необходимо заменить на рас-
считанные выше значения. Количество постов в зоне ТО задается цифрой в операторе 
STORAGE. 

Максимальное количество постов в зоне ТО задается из следующего условия: рас-
четное требуемое количество постов ХТО-1 округленное до целых в большую сторону 
плюс три поста. Максимальное количество постов зоны ТО не должно быть меньше 
четырех. 
 
*Моделирование зоны ТО-1 с помощью двухканальной замкнутой СМО  
*с простейшим потоком требований* 
**************************************************************** 

INITIAL  X$AVTO,100   ; задание количества а/м = 100 ед. 
INITIAL  X$TIME_DO_TO,320  ; задание среднего времени, через которое 

; выполняется ТО-1 =320 ч. 
INITIAL  X$OBSL,1.81   ;задание среднего времени  

; на выполнение ТО-1 =1.81 ч. 
INITIAL  X$TIME_MODEL,2016  ; задание времени моделирования  

; работы зоны ТО-1 2016 ч. 
**************************************************************** 
ZONA_TO  STORAGE  2    ;создание зоны ТО с 2 постами 
INFORM  QTABLE  ON_TO,0,2,100   ;сбор статистических данных для таблицы  

       ;INFORM об очереди ON_TO 
GENERATE  ,,,X$AVTO   ;генерация транзактов, соответствующих  
     ;количеству автомобилей 

WORK  ADVANCE  (EXPONENTIAL(1,0,X$TIME_DO_TO)) ; задержка автомобиля  
;на время выполнение транспортной рабо-
ты, распред. 
; по экспоненциальному закону 

QUEUE  ON_TO    ; поступление а/м в ОЧЕРЕДЬ на пост ТО  
     ;(имя очереди ON_TO) 
ENTER ZONA_TO    ; занятие зоны ТО автомобилем 
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DEPART ON_TO    ; выход а/м из очереди 
ADVANCE  (EXPONENTIAL(1,0,X$OBSL)) ; задержка а/м на время  

;выполнения ТО-1, которое  
;распределено по экспоненц. закону 

LEAVE   ZONA_TO    ; а/м покидает зону ТО 
TRANSFER   ,WORK   ; переход на блок с меткой Work 

**************************************************************** 
GENERATE  X$TIME_MODEL  ; задание времени моделирования  

;зоны ТО  
TERMINATE  1    ;остановить моделирование 
START  1     ;запуск процедуры моделирования 
 

Сохраните созданные имитационные модели на диске R с именами Зона-
ТО1_1пост.gps; ЗонаТО1_2пост.gps и т.д. и распечатайте их. Выполните трансляцию 
моделей и сохраните отчеты REPORT по результатам моделирования с именами Зона-
ТО1_1пост.gpr; ЗонаТО1_2пост; и т.д. и распечатайте их. 

3. Анализ результатов моделирования 
3.1 Из каждого отчета по моделированию выберите и запишите в таблицу 5 необхо-

димые данные. 
 

Таблица 5 –Результаты моделирования зоны ТО-1 
Кол-во 
постов 
зоны 
ТО 

ПОСТn  

Очередь QUEUE Одноканальное FACILITY или многоканаль-
ное STORAGE устройство 

Средняя 
длина оче-

реди  
AVE.CONT. 

Среднее время 
нахождения ав-
томобиля в оче-
реди ТСР.ОЧ,  час 

AVE.TIME 

Количество 
выполненных 
ТО-1 за время 

моделирования 
NТО1Г, 

ENTRIES 

Коэффициент 
использования 
(загрузки) зо-
ны ТО Кисп, 

UTIL. 

Среднее 
число за-
нятых по-
стов ТО 
AVE.C. 

1 2 3 4 5 6 
1     для зоны 

ТО с 1 по-
стом 

AVE.C.= 
UTIL. 

2      
3      
4      

…..      
Nmax      

 
3.2 Постройте 5 графиков зависимостей показателей работы зоны ТО (столбцы под 

номерами 1-5) от количества постов в зоне ТО. 
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3.3 Определите оптимальное количество постов ТО-1 по критерию минимальных 
суммарных затрат от простоя автомобилей в ожидании обслуживания и затрат от про-
стоя постов ТО-1 (постов, оборудования, ремонтных рабочих) в ожидании требований на 
обслуживание.  

Для этого определяем суммарное время простоя автомобилей ПРОСТОЯ АВТОТ _∑  в ожи-
дании ТО-1 за время моделирования, а также затраты от простоя автомобилей ПР АВТОЗ .  
за время моделирования и заполняем таблицу 6: 

ПРОСТОЯ АВТО ТО Г СР ОЧТ N Т_ 1 .= ⋅∑ ,час; 

ПР АВТО ПРОСТОЯ АВТО ПР АВТОЗ Т С. _ .= ⋅∑ , д.е., 
где СПР.АВТО = 40 денежных единиц/час – потери прибыли за один автомобиле-час из-за 
простоя в ожидании ТО. 

Определяем суммарное время простоя постов ТО-1 ПРОСТОЯ ПОСТТ _∑  в ожидании по-
ступления автомобилей на ТО-1 за время моделирования, а также затраты от простоя 
постов ТО ПР ПОСТЗ .  за время моделирования и заполняем таблицу 6: 

ПРОСТОЯ ПОСТ ПОСТ МОД ИСПТ n Т К_ (1 )= ⋅ ⋅ −∑ ,час; 

ПР ПОСТ ПРОСТОЯ ПОСТ ПР ПОСТЗ Т С. _ .= ⋅∑ , д.е., 
где СПР.АВТО = 20 денежных единиц/час – потери прибыли из-за простоя одного поста в 
ожидании поступления автомобиля на ТО; МОДТ =2016 ч. – время моделирования зоны 
ТО-1. 

Суммарные затраты от простоя автомобилей в ожидании обслуживания и затрат от 
простоя постов ТО-1 в ожидании требований на обслуживание определяются 

ПР ПОСТ ПР АВТОЗ З З. .= +∑ , д.е. 

Данные заносим в таблицу 6 для каждого варианта зоны ТО-1. 
 

Таблица 6  – Результаты расчета суммарного времени простоя автомобилей, постов ТО, 
суммарных издержек 
Зона ТО с 
к-вом  по-
стов ПОСТn  

ПРОСТОЯ АВТОТ _∑
, час 

ПР АВТОЗ . , д.е. 
ПРОСТОЯ ПОСТТ _∑ , 

час 
ПР ПОСТЗ . , 

д.е. 
З∑ ,д.е. 

1      
2      
3      
4      

…..      
Nmax      
 
По данным таблицы 6 стройте на одной точечной диаграмме 3 графика зависимостей 

затрат от простоя автомобилей в ожидании обслуживания, затрат от простоя постов ТО-
1 в ожидании требований на обслуживание и суммарных затрат от количества постов 
зоны ТО-1. 
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Сделайте вывод о том, какое количество постов зоны ТО-1 является оптимальным 
по критерию минимальных суммарных затрат от простоя автомобилей в ожидании об-
служивания и затрат от простоя постов ТО-1 в ожидании требований на обслуживание. 
Сравните найденной оптимальное количество постов с рассчитанным ХТО-1. 

Содержание отчета 
Тема, задание, таблица с исходными данными, технологический расчет зоны ТО, 

расчет показателей СМО, сохраненные и распечатанные файлы моделей и отчетов по 
ним для каждого варианта зоны ТО, таблица 5 и графики по ней, расчет затрат, таблица 
6 и графики по ней, вывод об оптимальном количестве постов ТО-1, ответы на кон-
трольные вопросы. 

Контрольные вопросы 
1. Каким видом СМО моделируется зона ТО? 
2. Назовите основные элементы СМО при моделировании зоны ТО-1. Что они моде-

лируют, каким объектам имитационной модели соответствуют, какими параметра-
ми характеризуются? 

 
3.3 Оптимизация зоны текущего ремонта (ТР) автомобилей АТП с использова-

нием имитационного моделирования 
Задание: Определить оптимальное количество регулировочных и разборочно-

сборочных постов ТР по критерию минимальных суммарных затрат от простоя 
автомобилей в ожидании ТР и затрат от простоя постов ТР  в ожидании требований на 
обслуживание. При этом необходимо рассмотреть зону ТР с 1, 2, 3 и более постами. 

Исходные данные: Исходные данные принимаются в зависимости от номера 
варианта (см. таблицу А.2).  

Порядок выполнения 
1. Подготовка данных для моделирования 
1 Определяем годовой объем работ ТР определяется по формуле: 

Г Г И ТР
ТР

L A tT = 1000
⋅ ⋅ , чел.-ч. 

где LГ. - годовой пробег автомобилей, км (принимается по данным предыдущей лабора-
торной работы);  Аи - списочное количество ПС; tТР - удельная скорректированная трудо-
емкость ТР, чел.-ч/1000км. 

2 Определяем годовой объем постовых регулировочных и разборочно-сборочных ра-
бот ТР. Для грузовых автомобилей он составляет b = 34%, а для автобусов b = 35% от 
годовой объем работ ТР: 

Г
ТРT , .
100

Г
РРСБ

bT чел ч⋅
= −  

3 Определяем количество отказов NОТК за год для заданного количества автомобилей 
ОТК ГN L ω= ⋅ , 

где ω - параметр потока отказов, отк./1000 км. 
4 Определяем годовой фонд времени работы зоны ТР ЗОНЫ ТРФ _  (равен времени мо-

делирования зоны ТР МОДФ ) 
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МОД ЗОНЫ ТР РАБ ТР СМФ Ф С Д Т_ .= = ⋅ ⋅ , час, 
где С=2 – количество смен работы, ДРАБ.ТР = 302 – количество дней работы зоны ТР в 
году, Тсм=8 ч - длительность смены постов регулировочных и разборочно-сборочных 
работ зоны ТР.  

5 Определяем среднее время, через которое автомобиль требует ремонта и поступа-
ет в зону ТР. 

Пробег, через который возникнет отказ у автомобиля, определяется 
1000 ,ОТКАЗL км
ω

=  

Определяем математическое ожидание (среднее значение) интервала времени рабо-
ты зоны ТР, через которые автомобиль поступит на ТР – ТТРЕБ-ТР, час.  

Для этого находим количество дней, через которые возникает отказ автомобиля 
ОТКАЗL

дней
CC

N
L

=  

Количество дней округляется до целых. 
Математическое ожидание (среднее значение) интервала времени работы зоны ТР, 

через которые автомобиль поступит в ТР 
ТРЕБ ТР дней CMT N T C_ = ⋅ ⋅ , час. 

6 Среднее время выполнения одного текущего ремонта 

_ ,
Г

РРСБ
ВЫП ТР

ОТК РАБ

TТ час
N Р η

=
⋅ ⋅

, 

где численность рабочих, одновременно работающих на посту ТР РРАБ = 1.5 чел; коэф-
фициент использования рабочего времени поста η=0,97[3]. 

7 Определяем требуемое количество регулировочных и разборочно-сборочных по-
стов ТР XТР по типовой методике технологического расчета:  

Г
РРСБ

ТР
РАБ ТР см РАБ

TХ
Д Т С Р.

ϕ
η

⋅
=

⋅ ⋅ ⋅ ⋅
; 

где Г
РРСБT - годовой объем работ на регулировочных и разборочно-сборочных постах ТР, 

чел.-ч.; РАБ ТРД .  =302 - число рабочих дней в году постов ТР; ϕ - коэффициент неравно-
мерности загрузки (резервирования) постов, ϕ = 1,25.  

2. Создание имитационной модели зоны ТР с использованием СМО  
Для моделирования зоны ТР используются одно- и многоканальные замкнутые 

СМО. Элементы СМО при моделировании зоны ТР аналогичны элементам СМО при 
моделировании зоны ТО-1 (см. предыдущую лабораторную работу), за исключением то-
го, что входящий поток и очередь образуется автомобилями, требующими ТР, каналами 
обслуживания являются посты ТР, выходящий поток образуется отремонтированными 
автомобилями.  

Имитационные модели зоны ТР совпадают по виду с имитационными моделями зоны 
ТО (см. предыдущую лабораторную работу), при этом в них нужно внести следующие 
изменения в используемые переменные: 
AVTO    - количество заданных автомобилей Аи, ед 
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TIME_DO_TO  - среднее время, через которое автомобиль требует ремонта и по-
ступает в зону ТР  ТТРЕБ_ТР, час. 
OBSL    - среднее время выполнения одного текущего ремонта ВЫП ТРТ _ , час 
TIME_MODEL  - время моделирования работы зоны ТР ТМОД, час, которое соответ-
ствует времени работы зоны ТР в течение одного года. 

Максимальное количество постов в зоне ТР задается из следующего условия: рас-
четное требуемое количество постов ХТР округленное до целых в большую сторону 
плюс три поста. Максимальное количество постов зоны ТР не должно быть меньше 
четырех. 

Сохраните созданные имитационные модели на диске R с именами Зо-
наТР_1пост.gps; ЗонаТР_2пост.gps и т.д. и распечатайте их. Выполните трансляцию 
моделей и сохраните отчеты REPORT по результатам моделирования с именами Зо-
наТР_1пост.gpr; ЗонаТР_2пост; и т.д. и распечатайте их. 

3. Анализ результатов моделирования 
Анализ результатов моделирования выполняется как в предыдущей лабораторной 

работе. 
3.1 Из каждого отчета по моделированию зоны ТР выберите и запишите в таблицу 5 

необходимые данные, при этом внесите необходимые изменения в обозначения столб-
цов таблицы. 

3.2 Постройте 5 графиков зависимостей показателей работы зоны ТР (столбцы под 
номерами 1-5) от количества постов в зоне ТР 

3.3 Определите оптимальное количество постов ТР по критерию минимальных сум-
марных затрат от простоя автомобилей в ожидании ТР и затрат от простоя постов ТР 
(постов, оборудования, ремонтных рабочих) в ожидании требований на ТР.  

Расчеты выполняются аналогично предыдущей лабораторной работе, заполняется 
таблица 6, в которую вносятся необходимые изменения в обозначениях. 

По данным таблицы 6 стройте на одной точечной диаграмме 3 графика зависимостей 
затрат от простоя автомобилей в ожидании ТР, затрат от простоя постов ТР в ожидании 
требований на ТР и суммарных затрат от количества постов зоны ТР. 

Сделайте вывод о том, какое количество постов зоны ТР является оптимальным по 
критерию минимальных суммарных затрат от простоя автомобилей в ожидании ТР и за-
трат от простоя постов ТР в ожидании требований на ТР. Сравните найденной опти-
мальное количество постов с рассчитанным ХТР. 

Содержание отчета 
Тема, задание, таблица с исходными данными, расчет дынных для моделирования 

зоны ТР, сохраненные и распечатанные файлы моделей и отчетов по ним для каждого 
варианта зоны ТР, таблица 5 и графики по ней, расчет затрат, таблица 6 и графики по 
ней, вывод об оптимальном количестве постов ТР, ответы на контрольные вопросы. 

Контрольные вопросы 
1. Каким видом СМО моделируется зона ТР? 
2. Назовите основные элементы СМО при моделировании зоны ТР. Что они модели-

руют, каким объектам имитационной модели соответствуют, какими параметрами 
характеризуются? 
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Приложение А 

Таблица А.1 – Исходные данные для задания № 1.  
Вар № Время между поступлениями автомо-

билей на АЗС Tпост, мин 
Время на выполнение заправки авто-
мобиля, Тзапр, мин 

 
Среднее значе-

ние 
Величина  
разброса 

Среднее значе-
ние 

Величина  
разброса 

1 2,5 0,8 5 1,5 
2 3 1,2 6 2,4 
3 3,5 1,8 7 3,5 
4 4 2,0 8 4 
5 4,5 2,7 9 5,4 
6 5 1,5 10 3 
7 5,5 2,2 11 4,4 
8 5 2,5 10 5 
9 4,5 2,3 9 4,5 
10 4 2,4 8 4,8 
11 3,5 1,1 7 2,1 
12 3 1,2 6 2,4 
13 2,5 1,3 5 2,5 
14 5 2,5 10 5 
15 6 3,6 12 7,2 
 



 

 

Таблица А.2 - Исходные данные для задания № 2, 3 
Вар 
№ 

Модель транс-
портного средства 

LН ТО1,  
тыс. км 

LН ТО2,  
тыс. км 

LНСП,  
тыс. км 

tНТО1,  
чел.-ч 

tТР, 
чел.-ч/1000км 

L СС,  
км Аи, ед. ω,  

отк./1000км 
1 ПАЗ-3206 3 12 320 5,5 5,3 220 100 0,080 
2 ЛАЗ-695Н 3,5 14 400 5,8 6,5 225 105 0,069 
3 РАДЗIМIЧ А092 10 20 400 8,99 7 230 110 0,049 
4 ПАЗ-4230 4 16 400 9,63 8 235 115 0,060 
5 МАЗ-256 5 20 500 11,43 6,9 240 120 0,048 
6 НЕМАН-5201 5 20 500 11,72 7,9 245 125 0,047 
7 МАЗ-103 7,5 25 600 13,17 12,5 250 130 0,039 
8 МАЗ-103С 5 20 600 13,17 12,5 230 135 0,047 
9 МАЗ-104 6 25 600 13,03 12,5 235 140 0,038 
10 МАЗ-152 7,5 30 600 14,33 12,5 240 145 0,030 
11 МАЗ-203 10 30 600 17,03 13 245 150 0,032 
12 МАЗ-53371 8 24 600 4,6 5,2 250 145 0,041 
13 МАЗ-53362 8 24 600 3,2 5,8 255 140 0,040 
14 МАЗ-534005 15 30 600 6 6 260 135 0,031 
15 КАМАЗ-55102 4 12 380 1,91 6,7 190 130 0,081 
16 МАЗ-555102 5 20 380 4,51 7 195 125 0,046 
17 МАЗ-555402 4 16 250 5,31 6,7 200 120 0,062 
18 КРАЗ-256Б1 2,5 12,5 160 3,7 6,4 205 115 0,078 
19 КАМАЗ-55111 4 12 380 1,91 6,7 210 110 0,083 
20 КАМАЗ-65111 4 16 380 1,91 6,9 215 105 0,060 
21 МАЗ-5516 5 20 380 5 6,8 220 100 0,048 
22 ГАЗ-САЗ-3701-01 2,5 12,5 250 2,2 3,8 225 105 0,078 
23 МАЗ-457041 5 20 300 4,8 4,1 230 110 0,047 
24 ГАЗ-3309 5 20 300 2,7 3,3 235 115 0,050 
25 ГАЗ-33021 10 20 300 6,82 3,6 240 120 0,049 
Примечания 
1 Категория условий эксплуатации – III; климатический район – умеренно-теплый влажный; пробег с начала эксплуатации в долях от нормативного пробега 
– до 0,25; количество дней работы в году: для автомобилей– 302 дня, для автобусов – 365 дней; режим работы зоны ТО-1 : 252 дня в году, 1 смена, продол-
жительность смены 8 часов, режим работы зоны ТР: 302 дня в году. 2 смены, продолжительность смены 8 часов.  
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